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RESUME. L'ensemble des consignes rassemblees ci-dessous s'organise en trois rubriques. La 
redaction remercie les auteurs pour le strict respect qu'i/s accorderont a ces dispositions. La 
taille de ce resume ne doit pas depasser une dizaine de lignes. II est a composer en Times 
corps 9 italique, interligne 11 points. Un resume en anglais doit /'accompagner. L'ensemble 
des consignes rassemblees ci-dessous s'organise en trois rubriques. La redaction remercie /es 
auteurs pour /e strict respect qu'ils accorderont aces dispositions. La taille de ce resume ne 
doit pas depasser une dizaine de /ignes. II est a composer en Times corps 9 italique, interligne 
II points. Un resume en anglais doit /'accompagner. 

ABSTRACT. The instructions put together below fall into three categories. The editor would be 
grateful to authors for respecting these indications. At times, the length of this summary may 
attain a dozen lines. It is to be written in size 9 italic Times. An abstract in French will be 
joined. The instructions put together below fall into three categories. The editor would be 
grateful to authors for respecting these indications. At times, the length of this summary may 
attain a dozen lines. It is to be written in size 9 italic Times. An abstract in French will be 
joined. 

MOTS-CLES : un maximum de mots significatifs, en franfais et en anglais, doivent etre isotes 
sous forme de mots-cles. 

KEY WORDS: a maximum of significant words, in French and in English, will be separated as 
key words. 

Signature de I' article : nom de Ia revue. Volume X- no X/1999, pages I ~X 
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1. Introduction 

Ce texte donne les consignes a respecter imperativement pour garantir Ia 
qualite et l'homogeneite des articles (qui, sauf exception, ne doivent pas depasser 20 
a 30 pages) a paraitre dans les revues publiees par HERMES Science Publications. 
Le present texte doit etre considere comme un modele, notamment pour Ia premiere 
page, l'en-tete, les inters, etc. Vous trouverez en annexe II, Ia Iiste des logiciels 
acceptes par le service informatique. 

2. Presentation 

L'ensemble des textes est compose en Times romain (Times New Roman sous 
PC) corps 10, minuscule, interligne 12 points exactement, sans cesure dans le texte, 
avec un alinea de premiere ligne de 5 mm. Un espace de 6 pts est defini apres les 
paragraphes. 

Les titres, sous-titres et autres resumes font l'objet d'un traitement particulier, 
explique ci-dessous. Par ailleurs, les auteurs qui desirent mettre en valeur un terme 
peuvent le faire en utilisant l'italique ou le gras, ne jamais utiliser le soulignement. 
Eviter au maximum d'utiliser les lettres majuscules dans les titres et dans le texte. 

2.1. Format 

Les pages possedent les caracteristiques suivantes : 
-largeur des textes (ou justification) : 120 mm exactement, 
-hauteur des textes, y compris les notes: 190 mm maximum. 
La I" page de !'article fait !'objet d'une mise en forme particuliere detaillee en 

2.2.1. Sur cette premiere page apparaltront les elements suivants : le titre de I' article, 
Ies nom et prenom des auteurs, leur appartenance, un resume et des mots-cles en 
francrais et en anglais. 

L'article commencera en haut de Ia page 2. Tousles textes sontjustifies. 

2.1.1. Marges et format 

Si vous utilisez Word sous PC ou Macintosh, les marges a definir sont les 
suivantes, pour justification et hauteur de page de facron a obtenir un bloc texte de 
120 mm X 190 mm ; dans Menu, aller a : 
- Fichier > Mise en page H 

B 
G 

em 

5,35 em Exactement 
5,35 em Exactement 
4,5 em En-tete 4,4 

D 4,5 em Pied de page 0 em 
> Disposition : En-tetes X pages paires et impaires differentes X 1 o page differente 
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- Fichier >Format d'impression A4 
- Outils > Paragraphes > Enchainement X eviter veuves et orphelines 
- Outils >Options > Impression X Reglage fin pour largeur X Dessins 

>Composition automatique X Remplacer guillemets " par << » 

2.1.2. En-tete 

La pagination et les titres courants de !'article seront inseres dans !'en-tete. 
- Insere > Numeros de page > Position Haut de page> Format...> I, 2, 3 ... 11. partir de 1 
- Affichage >En-tete> en-tete de page impaire: inserer le titre courant de l'article et, 
separee de 5 espaces, Ia pagination, I' ensemble en Times romain maigre, corps 9. 

> en-tete page paire : inserer le nom de Ia revue et, separee de 5 espaces, 
Ia pagination, I' ensemble en Times romain maigre, corps 9. 

2.2. Titres et sous-titres 

2.2.1. Premiere page de /'article 

- Le titre de !'article en fran'tais, et indique en annexe le titre en anglais (ou 
!'inverse selon Ia langue utilisee) doit etre informatif et concis (de 3 a 8 mots 
significatifs). Dans le cas ou il excederait 40 caracteres ou espaces, !'auteur en 
fournira une version abregee (pour Je « titre courant » a inserer par vos soins dans Je 
premier en-tete des pages impaires). 

Le titre est compose en corps 18 gras romain minuscule, interligne 12 points. Si 
le titre comporte deux !ignes, inserer une ligne de blanc entre les deux !ignes. S'il y a 
un sous-titre, il sera en corps 14 gras romain. II sera precede et suivi de deux !ignes 
de blanc et borde d'un trait superieur fin. (Format> Bordure superieure en trait fin) 

- Le prenom et Je nom des auteurs sont composes en corps 12 gras romain 
minuscule, interligne 12 points. 

- Les coordonnees des auteurs (appartenance, adresse professionnelle et adresse 
electronique, pas de telephone ni de fax) sont composees en corps 10 italique 
maigre, interligne 12 points. Elles seront precedees et suivies d'une ligne de blanc. 

Un modele de premiere page comportant plusieurs auteurs a des adresses 
differentes est donne en annexe I. 

- Le resume et les mots-cles sont donnes imperativement en fran'tais et en 
anglais, dans J'ordre suivant: resume, puis abstract, puis mots-c!es, puis key words 
si !'article est redige en fran'tais. Abstract, puis resume, puis key words, puis mots­
des si !'article est redige en anglais. 

Cet ensemble est compose en corps 9 italique maigre, minuscule, interligne 
J 1 points sauf les termes : RESUME ABSTRACT. MOTS-CLES: KEY WORDS: qui sont composes 
en capitales accentuees en corps 7, suivis, comme sur ce modele, d'un point ou de 
deux points, et entre 2 filets (trait fin) en bordures superieure et inferieure, distance 
au texte de 4 points. 

-Sur Ia derniere Iigne de cette premiere page apparaitra Ia signature de !'article 
comprenant Je nom de Ia revue, Je numero du volume et l'annee de parution ainsi 
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que le numero des pages dans le volume. Celle-ci est composee en corps 9 romain 
maigre, minuscule, et sera mise a jour tors de Ia composition du numero de Ia revue 
par le service fabrication. 

2.2.2. Titre des paragraphes ou titre d' « inter» 

lis sont tous alignes sur Ia marge gauche en numerotation decimale : 
-le premier niveau est en Times corps 10 minuscule, chiffres et texte en romain 

gras (exemple: 2. Titre de niveau 1), 
- le deuxieme niveau est en Times corps 10 minuscule, chiffres en romain gras, 

texte en italique gras (exemple: 2.1. Titre de niveau 2), 
- le troisieme niveau est en Times corps 10 minuscule, chiffres en romain 

maigre, texte en italique maigre ( exemple : 2.l.I. Titre de niveau 3), 
- Ie quatrieme niveau est en Times corps 10 minuscule, chiffres et texte en 

romain maigre ( exemple : 2.I.I.I. Titre de ni veau 4 ). 
Pour chaque titre d'inter de premier et deuxieme niveaux, ii faut prevoir deux 

!ignes de blanc au-dessus et une ligne de blanc en dessous; pour chaque titre d'inter 
de troisieme et quatrieme niveaux une ligne de blanc au-dessus et une ligne de blanc 
en dessous. 

2.3. Les alineas 

Ils sont d'un renfoncement (ou retrait de Ire ligne) de 5 mm. 

2.4. Les notes de bas de page1 

Elles sont en bas de page, en corps 9, interligne 11 points, justifie sans alinea, 
numerotees de I a n a l'interieur de I'article, separees du texte proprement dit par un 
blanc d'une ligne et surmontees d'un filet maigre de 2,5 em. L'appel de note dans Ie 
texte est en corps 8. 

2.5. Figures et tableaux 

Les figures, illustrations et tableaux doivent etre incorpores au texte. Les figures 
et illustrations sont numerotees de I a n a l'interieur de l'article, les tableaux 
egalement. Des legendes explicites les accompagnent, composees en Times corps I 0 
justifiees, Figure x en romain gras suivi d'un point gras, texte en italique maigre: 

1 Note composee en corps 9, sans alinea. 
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Cadre et quadrillage en trait fin. Une ligne de blanc au-dessus, une ligne de blanc entre Ia 

figure ou le tableau et Ia lt!gende. Deux !ignes de blanc sous Ia lt!gende. 

Figure 3. Consignes 

2.6. Formules 

Celles d'entre elles qui font l'objet d'un renvoi dans le texte sont numerotees de 
[I] a [n] entre crochets. Ce numero, place sur Ia premiere (ou Ia derniere) ligne de Ia 
formule, est aligne sur Ia marge de droite. Une ligne de blanc au-dessus et au­
dessous de Ia formule separe celle-ci du reste du texte. Si Ia formule doit etre coupee 
(pour cause de longueur) mettre 1/2 ligne de blanc entre les }ignes de }'expression. 

2. 7. Enumerations 

Les auteurs utiliseront uniquement des tirets, de differentes tailles s'il existe 
plusieurs niveaux. Ne pas utiliser de puces ou de fleches. Exemple : 

- Les auteurs utiliseront uniquement des tirets, de differentes tailles ... 
- Les auteurs utiliseront uniquement des tirets, de differentes tailles ... 

- Les auteurs utiliseront uniquement des tirets, de differentes tailles ... 

Le texte doit toujours revenir en debut de ligne et respecter Ia justification 
(largeur de Ia ligne) de 120 mm. 

2.8. Remarque ou note 

Les « remarque » ou « note >> se composent en petites capitales maigres suivies 
d'un point, puis d'une espace, puis d'un tiret long: 
NOTE. - . .. REMARQUE. - ... 

2.9. Typographie 

Pour les textes rediges en fran'rais : 
Une seule espace apres le . Une espace apres « et une espace avant» 
Une espace avant: mais pas d'espace apres "ni avant" 
Une espace avant ; Pas d'espace avant une virgule ou un point 
Une espace avant? Pas d'espace interieure pour(. .. ){ ... }[ ... ] 
Une espace avant % Points de suspension= ... (trois points) sans 
Une espace avant et apres = +- espace avant mais etc. 
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Pour les textes rediges en anglais, Ia typographie est differente (pas d' espace 
avant les: ; ? % et guillemets "pour I'anglais" sans espace). 

2.10. Remerciements 

Le texte des remerciements se place apres Ia conclusion separe de celle-ci par 
deux !ignes de blanc, avant Ia bibliographie, sous Ia forme (ceci est un modele, texte 
a votre convenance) : 

Remerciements 

Les auteurs tiennent a remercier le laboratoire pour son soutien ... 

2.11. Bibliographie 

Composees en corps 9 romain, interligne II points, les references sont 
rassembtees en fin d'article par ordre alphabetique, espacees les unes des autres de 
6 points ; leur numero, du type [KOL 97], est place entre crochets. Le nom de 
!'auteur est compose en petites capitales, avec un alinea negatif de 5 mm (dans 
Menu, aller a : Format > Paragraphe > Retrait de I,. ligne Negatif de 0,5 em). 

Voici, en guise d'exemple, quelques cas de figures parmi les plus courants : 

-pour les ouvrages (titre en italique, le reste en romain) 

[KOL 97) KOLSKI C., lnteifaces homme-machine, Editions Hermes, Paris, 1997. 

- pour les revues et actes de conferences publies (titre de Ia revue ou de Ia 
conference en italique, le reste en romain) 

[OEM 94) DEMEURE I., FARHAT J., << Systemes de processus legers : concepts et exemples », 

Technique et Science /nformatiques, vol. 13, n° 6, 1994, p. 765-795, Hermes, Paris. 

[LAL 97] LALLOUET A., << DP-LOG : un langage logique data-parallele >>, Acres des 

6' journees francophones de programmation logique et programmation par contraintes 

JFPLC'97, Orleans, 26-28 mai 1997, Editions Hermes, Paris, p. 53-68. 

-pour les rapports internes et les theses (texte tout en romain) : 

[BRA 95) BRAUN T., OIOT C., HoGLANDER A., RoCA V., «An experimental user level 
implementation of TCP >>, rapport de recherche no 265, septembre 1995, INRIA. 

[NAW 97) NAWROCKI A., <<Contribution a Ia modelisation des cables monotorons par 
elements finis >>, These de doctoral, Universite de Nantes, Ecole Centrale de Nantes, 
1997. 
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2.12. Biographie 

Pour les revues qui demandent une biographie, les auteurs indiqueront en 
quelques !ignes placees en fin d'article, les evenements essentiels de leur carriere en 
insistant sur leurs domaines d' interet techniques et scientifiques. Ce texte do it etre 
compose en Times corps 9 italique, interligne II points, justifie sans alinea, separe 
de Ia derniere ligne de I' article par deux !ignes de blanc, nom de I' auteur en 
caracteres gras, texte en caracteres maigres. Une ligne de blanc est a inserer entre 
chaque auteur. Exemple : 

Beatrice Sorel est ingenieur ... Elle est actuellement allocataire de recherche et prepare une 
these au sein du ... Ses travau.x portent sur /'utilisation de techniques forme lies ( algebre des 
corps finis, meta-modelisation, logique temporelle) pour la verification, Ia validation et Ia 
simulation du GRAFCET. 

Yves Saulnier est professeur agrege et docteur de ... en automatique. II est actuellement 
maitre de conferences habilite et directeur du .... Ses activites de recherche concernent les 
methodes d'ingenierie integree des systemes de production complexes et les langages de 
description des systemes reactifs. 

3. Remise des articles 

Les articles adresses en soumission seront envoyes en 6 exemplaires au n!dacteur 
en chef de Ia revue concernee, aupres de HERMES Science Publications. Tous les 
documents etant numerises, nous remercions les auteurs de bien vouloir prendre 
contact, des Ia saisie de leur article, avec le service informatique, afin de verifier Ia 
compatibilite des fichiers et les sources utilisees. 

Les articles, apres acceptation definitive, seront adresses en document attache a : 
hermes@iway. fr 

ou sur disquette (fichier source et version postscript) accompagnee d'une sortie 
papier laser, pour document temoin, et d'une copie des polices de caracteres 
utilisees, dans le cas de symboles particuliers. 

Les auteurs ayant utilise Latex doivent fournir les fichiers sources (* .tex, 
*.sty, ... ) et Ia version postscript. Si un style french a ete utilise, celui-ci doit etre 
fourni. 

Les articles qui ne respecteront pas exactement ce format ne pourront pas etre 
pris en consideration. 

Nous prions les auteurs d'indiquer leurs numeros de telephone, de telecopie et 
leur adresse electronique. 

Nous restons a votre disposition pour toute information complementaire. 

LE SERVICE FABRICATION 

hermes@iway.fr 
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Annexe I 

Nous donnons un modele de presentation du haut de Ia premiere page dans le cas 
de plusieurs auteurs et de plusieurs appartenances. Les auteurs sont separes par un 
tiret long (caractere special) maigre. L'appartenance est notee par une (ou plusieurs) 
etoile(s) qui sera placee en correspondance avant le texte de I' appartenance. Pour 
une adresse electronique commune a plusieurs auteurs, les noms des auteurs seront 
reunis entre deux accolades, separes chacun par une virgule. 

Si I' article appartient a une rubrique, le nom de celle-ci sera insere au-dessus du 
filet superieur, compose en petites capitales, Times corps 14 maigre. Exemple: 

RECHERCHE 

Couplage endommagement-decalcification 
du beton 
Etude d 'one modelisation numerique 

* •• B G' d** G" Pi" d • ••• Laurmt Molez ' - runo erar - illes ~au ier-Cabot ' 

• Laboratoire de Mecanique et Technologie, ENS de Cachan 
CNRS/Universite Pierre et Marie Curie 
61 avenue du President Wilson, F-94235 Cachan cedex 

{nom, nomj@laboratoire.fr 
•• 

Electricite de France, Direction des Etudes et Recherches 
Dept. MTC, BP 1, F-77818 Moret-sur-Loing cedex 

*** lnstitut Universitaire de France 

Annexe II 
Liste des logiciels acceptes 

-Word 6 et Word 98 sous Macintosh 
-Word 6 et 7 (Word 95) et Word 97 sous PC 
- Latex version 2e Uoindre le fichier PS) 

Les feuilles de style sont disponibles sur 
http://www.hermes-science.com/cad_aute.htm 




